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Executive summary

Dell Inc. (Dell) commissioned Principled Technologies KEY FINDINGS

(PT) to compare Dell’s online ImageDirect image creation

process with a typical corporate deployment solution such e Deploying systems with Dell ImageDirect

as Microsoft's ImageX command-line tool, a leading saved as much as 73 percent of IT staff time
solution many organizations use. The test aimed to over using an imaging tool such as Microsoft
measure and compare the potential time an organization’s ImageX.

IT staff might invest using the two imaging solutions and

deployment processes across multiple locations. e Deploying systems for users in remote

facilities with Dell ImageDirect saved as
much as 82 percent of IT staff time over

We selected four commonly available systems that Dell . ) ; :
using an imaging tool such as Microsoft

ImageDirect supports with Microsoft® Windows® 7

Enterprise: ImagexX.
e Dell™ Latitude™ E5400 notebook e Creating images using Dell ImageDirect
e Dell Latitude E6400 notebook saved on average 93 percent of IT staff time
e Dell OptiPlex™ 780 desktop over creating the images with an imaging tool
e Dell Precision™ T1500 desktop such as Microsoft ImageX.

With the ability to order systems with a customized,
preinstalleq image or build customized images for to deploy an image on a different Dell model,
download ina few clicks of thg mouse button, we found as our tests on the Dell OptiPlex 780 and
that ImageDirect could save significant amounts of IT staff Ereslisian TIEEE Sha

members’ time, time they would normally devote to
imaging using a tool such as Microsoft ImageX.

e Dell ImageDirect required no additional time

We first created a standard company system image using both ImageDirect and ImageX on a Dell Latitude E5400
notebook. We used ImageX as many small, medium-sized, and large organizations would. The difference
between those usage models is that smaller organizations with fewer systems are more likely to install
applications by hand. Larger organizations would develop silent installation scripts to speed up repeated
application installations. We then ordered a Dell OptiPlex 780 desktop system using the image created and tested
through Dell’'s ImageDirect service. We tested the other systems using the images created from ImageDirect and
compared setup times with the systems we used ImageX to set up. We repeated this process on the Dell Latitude
E6400, changing the systems to mimic what would happen over time as an organization buys new and different
systems and updates images, possibly distributing them across multiple sites.

Time savings of Dell ImageDirect over Microsoft ImageX

Area of time Dell Latitude Dell Latitude Dell OptiPlex Dell Precision acrﬁ\s/:rsl??our
savings E5400 E6400 780 T1500 systems

One-time setup

0:00:00 (N/A) 0:52:13 (78%) 0:34:36 (100%) | 0:36:47 (100%) 0:30:54 (93%)
(percentage)

Deployment

0:28:01 (70%) 0:24:17 (67%) 0:18:20 (69%) 0:14:20 (73%) 0:21:14 (69%)
(percentage)

Remote site
deployment 0:37:47 (76%) 0:34:03 (74%) 0:27:39 (77%) 0:24:07 (82%) 0:30:54 (77%)
(percentage)

Figure 1. The time savings of Dell ImageDirect over Microsoft ImageX for setting up images and deploying images on systems (both
at the central site and at remote sites). The time differences are in hours:minutes:seconds, with percentage differences in
parentheses.




Figure 1 shows both the time savings and percentage time savings of ImageDirect over ImageX in our image
creation testing. These savings are what a small organization that does not use silent installations during their
imaging process might expect. We base the times in Figure 1 not on elapsed times, but rather on the time an IT
staff member would actually have to devote to a task. For example, if the task of copying an image to a system
took a total of 40 minutes, but the actual time to start up the image copy and monitor its progress only took 8
minutes, we used the 8-minute figure. The 100% savings indicates that there was no time required for
ImageDirect imaging when switching to a different model of computer.

The one-time setup time is the time necessary to create an image for a system, either with ImageDirect or
ImageX. This time would be necessary for each image within a customer’s environment. IT staff members could
then deploy that image on multiple similar systems. With ImageDirect, IT staff members could also deploy the
ImageDirect image on different types of Dell systems with no additional setup time. Because we assume the initial
image is already created for the Dell Latitude E5400, no time is necessary with either method and no time savings
result. The deployment time is what is necessary to get the boxed up system unboxed, imaged, and personalized
for the user. The remote site deployment time is the deployment time plus the necessary time to box the system
back up, prepare it for shipping to the remote location, and unbox it there upon arrival.

We calculated our times on the ImageDirect builds from the point after SYSPREP to creating the user and getting
to the Windows desktop. We captured the ImageX imaging comparison times from the point of powering on the
system to the point that we created the user and the Windows desktop appears. We found these times to be
much faster than with the ImageX setup, especially when it came to ordering a pre-configured system.

Test methodology

We first tested a Dell Latitude E5400 notebook system with an existing image. We then tested a Dell Precision
T1500 desktop system with as similar an image as possible. This is the situation the IT staff faces when adding a
new model of computer to the set of computers they already support. We chose a desktop to emphasize the
differences when compared with a notebook. We also tested a Dell Latitude E6400 notebook with an updated
image. This situation is a common one, where the IT staff needs to add updates, new applications, and make
other changes over time. We completed the test by ordering a Dell OptiPlex 780 from the factory with the
customized image already installed.

The initial image contained the following applications as part of our hypothetical company’s corporate build:
e Adobe® Acrobat® Reader 8.1.2

Adobe Photoshop® CS5

Adobe Dreamweaver® CS5

Microsoft Access® 2007

Microsoft Excel® 2007

Microsoft Outlook® 2007

Microsoft PowerPoint® 2007

Microsoft Project 2007

Microsoft Word 2007

Microsoft Visio® 2007

Microsoft Groove® 2007

Microsoft OneNote® 2007

Microsoft Publisher 2007

Microsoft InfoPath® 2007

SPEC®jbb®2005 v1.07

Symantec EndPoint Protection 11.0.4

Winzip® 14.5

We also set the following in the image:
e Microsoft Internet Explorer® (IE) home page to www.principledtechnologies.com
e Corporate desktop wallpaper
e Corporate-mandated policy settings:
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o Under Security Settings->Account Policies>Password Policy->Change Maximum Password age
to 20 days

o Under Security Settings—>Local Policies>User Rights Assignment->Add Administrator to Lock
pages in memory (recommended for running SPECjbb2005)

o Under Security Settings—>Local Policies> Security Options>Rename guest account to PTGuest

For the Dell Precision T1500 system, we recorded the amount of time that it took to deploy the corporate image
using the two imaging tools.

On the Dell Latitude E6400, we updated the corporate image to simulate quarterly changes. We made the
following changes to the image:
e Replaced Symantec EndPoint Protection 11.0.4 with McAfee® VirusScan Enterprise 8.5i
e Replaced Adobe Reader 8.1.2 with Adobe Reader 9.3
e Changed IE home page from www.principledtechnologies.com to www.dell.com
o Added one system policy: Under Security Settings—>Local Policies—> Security Options>Rename
Administrator account to PTAdmin

For the Dell OptiPlex 780 order from the factory, we recorded the time from powering on the system to the
Windows desktop as well as how long it would take to use ImageX to build and image the system.

Dell Latitude E5400 notebook
We measured the amount of time we used with each of the two imaging solutions—Dell ImageDirect and
Microsoft ImageX—to go from unboxing the notebook to having a functioning system with the following
applications and settings:
e Adobe Acrobat Reader 8.1.2
Adobe Photoshop CS5
Adobe Dreamweaver CS5
Microsoft Access 2007
Microsoft Excel 2007
Microsoft Outlook 2007
Microsoft PowerPoint 2007
Microsoft Project 2007
Microsoft Word 2007
Microsoft Visio 2007
Microsoft Groove 2007
Microsoft OneNote 2007
Microsoft Publisher 2007
Microsoft InfoPath 2007
SPECjbb2005 v1.07
Symantec EndPoint Protection 11.0.4
WinzZip 14.5

We also set the following in the image:
e |E home page to www.principledtechnologies.com
e Corporate desktop wallpaper
e Corporate-mandated Policy settings
o Under Security Settings—>Account Policies=>Password Policy->Change Maximum Password age
to 20 days
o Under Security Settings—>Local Policies>User Rights Assignment->Add Administrator to Lock
pages in memory (recommended for running SPECjbb2005)
o Under Security Settings->Local Policies> Security Options>Rename guest account to PT
Guest
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Dell Precision T1500 desktop
We measured the amount of time we used with each of the two imaging solutions—Dell ImageDirect and
Microsoft ImageX—to go from imaging the desktop to having a functioning system with the following applications
and settings:
e Adobe Acrobat Reader 8.1.2
Adobe Photoshop CS5
Adobe Dreamweaver CS5
Microsoft Access 2007
Microsoft Excel 2007
Microsoft Outlook 2007
Microsoft PowerPoint 2007
Microsoft Project 2007
Microsoft Word 2007
Microsoft Visio 2007
Microsoft Groove 2007
Microsoft OneNote 2007
Microsoft Publisher 2007
Microsoft InfoPath 2007
SPECjbb2005 v1.07
Symantec EndPoint Protection 11.0.4
WinZip 14.5

We also set the following in the image:
e |E home page to www.principledtechnologies.com
e Corporate desktop wallpaper
e Corporate-mandated Policy settings
o Under Security Settings—>Account Policies—>Password Policy->Change Maximum Password age
to 20 days
o Under Security Settings—>Local Policies>User Rights Assignment->Add Administrator to Lock
pages in memory (recommended for running SPECjbb2005)
o Under Security Settings—>Local Policies—> Security Options>Rename guest account to PT Guest

For the Dell Precision T1500 system, we recorded the amount of time that it took to deploy the corporate image
using the two imaging tools.

Creating the Dell Precision T1500 build using ImageDirect (2:46 recorded time)
Sign into the ImageDirect site (https://imagedirect.dell.com/imagedirect/logon.aspx?c=us&l=en&s=gen).
Click Manage Images.

Select desired image, and click Edit.

Click Edit Image again.

Click Image Name to rename image.

Click Save.

Click Restore Options.

Select desired Product Family platform for drivers.

. Select desired Model.

10. Click SAVE.

11. Click Build Image.

12. Click START IMAGE BUILD.

CoNoUAWNE

Creating the Dell Precision T1500 build using ImageX (37:40 recorded time)
Creating an answer file
1. Insert the Windows 7 product DVD into the DVD drive and locate the Install.wim file in the Sources folder.

2. Launch Windows SIM, a tool installed with the Windows AIK, to create an answer file.
3. On the File menu, click Select Windows Image, and navigate to the location of the Install.wim file.
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10.
11.
12.

13.
14.

15.
16.

17.

When the installation prompts you to create a catalog file, click Yes.

In the Answer File pane, choose Create a new answer file. The answer file is divided into the different
phases of Windows Setup, called configuration passes.

To add components to the answer file, right-click the desired component, and select the appropriate
configuration pass.

To see all of the possible components, expand the component list in the Windows Image pane. (Note:
When you add a component from this list, Windows SIM also adds all the parent settings for this
component to the answer file.)

Add the CreatePartition settings and the ModifyPartition settings.

All of the components and settings you added should appear in the Answer File pane. In the Properties
pane, under Settings, select a setting, and enter the appropriate value.

Set the default language of the installation to English (en-US).

Configure both disk partitions.

Accept the Microsoft Software License terms, and enter a product key to identify the edition of Windows
you are installing.

Select a default home page for Internet Explorer by configuring the InternetExplorer component.

Set the computer to boot to audit mode. (Note: Audit mode enables you to quickly boot to the desktop,
install additional applications and device drivers, and test the installation. With these settings configured
in the answer file, you can use the file to run an unattended installation, so that no user input is required
during Windows Setup.)

Validate the answer file, and resolve any errors.

Skip the several warnings for settings that have not been configured. These settings do not affect the
installation of Windows.

Save the answer file to the root directory of a USB flash drive, and name it Autounattend.xml

Building a reference installation

1.
2.

Insert the USB flash drive that contains the answer file, Autounattend.xml, into a reference computer.
Boot the computer by using the Windows 7 DVD. Next, customize the Windows image on the reference
computer so that you can duplicate it to the destination computers. Windows Setup starts automatically
and detects the answer file on the USB flash drive.
Windows Setup uses the settings specified in the answer file to configure the operating system. When
Windows Setup completes, the computer reboots into audit mode.
Use audit mode to verify customizations.
In audit mode, Windows displays the desktop and the System Preparation Tool, also known as Sysprep.
Use the Sysprep tool to remove computer-specific settings:
a. From the System Cleanup Action list, select Enter System Out-Of-Box Experience to configure
the computer to boot to Windows Welcome the next time it starts.
b. To remove hardware-specific information from the Windows installation, select Generalize.
c. You must use Generalize before you capture the Windows image, even if deploying to the same
hardware types.
d. Atthe Shutdown Options menu, set the computer to Shut down.

Capturing the customized Windows installation

1.
2.

Boot the computer to the Windows pre-installation environment by using a Windows PE CD.

The customized Windows installation created previously is available on the C drive of the reference
computer.

To copy the contents of the Windows installation to a .wim file, use the TmageX /capture command:

D:\imagex /capture C: C:\myimage.wim “my Win7 Install” /compress fast /verify
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Deploying the Windows image
1.

Boot the destination computer to the Windows PE CD (the destination computer is the computer onto
which you want to deploy the customized Windows image). When the computer boots from the Windows
PE CD, a command prompt opens.

Create and modify partitions on the hard drive using the script below and the DiskPart tool. (The script
creates a partition that is identical to the one created by the answer file used for the reference image. The
partition is the Windows partition, which will contain the operating system. The Windows partition is
assigned the drive letter C.)

X:\windows\system32>Diskpart /s d:\diskpartscript.txt

select disk O

clean

create partition primary
select partition 1

format fs=ntfs label="windows"
assign letter=C

active

exit

When the hard drive is formatted, copy the Windows image from the network location to the local hard
drive:

X:\windows\system32>copy e:\myimage.wim c:

Use the ImageX tool to apply the Windows image to the Windows partition on the C drive. This expands
the contents of the .wim file.

X:\windows\system32>D:\imagex /apply c:\myimage.wim 1 C

Use the BCDBoot tool to modify the boot-configuration data on the system partition:

E:>bcdboot C:\Windows

Dell Latitude E6400 notebook

We measured the amount of time we used with each of the two imaging solutions—Dell ImageDirect and
Microsoft ImageX—to go from imaging the notebook to having a functioning system with the following applications
and settings:

Adobe Acrobat Reader 8.1.2
Adobe Photoshop CS5
Adobe Dreamweaver CS5
Microsoft Access 2007
Microsoft Excel 2007
Microsoft Outlook 2007
Microsoft PowerPoint 2007
Microsoft Project 2007
Microsoft Word 2007
Microsoft Visio 2007
Microsoft Groove 2007
Microsoft OneNote 2007
Microsoft Publisher 2007
Microsoft InfoPath 2007
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SPECjbb2005 v1.07
Symantec EndPoint Protection 11.0.4
WinZip 14.5

We also set the following in the image:

IE home page to www.dell.com
Corporate desktop wallpaper
Corporate-mandated Policy settings
o Under Security Settings—>Account Policies—>Password Policy->Change Maximum Password age
to 20 days
o Under Security Settings—>Local Policies>User Rights Assignment->Add Administrator to Lock
pages in memory (recommended for running SPECjbb2005)
o Under Security Settings->Local Policies—> Security Options->Rename guest account to PT Guest
o Under Security Settings—>Local Policies—> Security Options->Rename Administrator account to
PTAdmiIn.

For the Dell Latitude E6400 notebook system, we recorded the amount of time that it took to deploy the corporate
image using the two imaging tools.

Creating the new Dell Latitude 6400 build using ImageDirect (4:07 recorded time)

Sign into the ImageDirect site (https://imagedirect.dell.com/imagedirect/logon.aspx?c=us&l=en&s=gen).
Click Manage Images.

Select desired image, and click Edit.

Click Edit Image again.

Click Image Name to rename image.

Click Save.

Click Customer Applications.

Uncheck Symantec Endpoint 11.0.6 I, and check VirusScan Enterprise 8.7i.

Uncheck Reader812, and check Adobe Reader 9.3.

. Check install order, and click SAVE.

. Click All Models Settings and edit command for installing antivirus.
. Click SAVE.

. Click Build Image.

Creating the Dell Latitude E6400 build using ImageX (52:13 recorded time)
Creating an answer file

1.

2
3.
4,
5

10.
11.

Insert the Windows 7 product DVD into the DVD drive and locate the Install.wim file in the Sources folder.
Launch Windows SIM, a tool installed with the Windows AIK, to create an answer file.

On the File menu, click Select Windows Image, and navigate to the location of the Install.wim file.
When the installation prompts you to create a catalog file, click Yes.

In the Answer File pane, choose Create a new answer file. The answer file is divided into the different
phases of Windows Setup, called configuration passes.

To add components to the answer file, right-click the desired component, and select the appropriate
configuration pass.

To see all of the possible components, expand the component list in the Windows Image pane. (Note:
When you add a component from this list, Windows SIM also adds all the parent settings for this
component to the answer file.)

Add two CreatePartition settings and two ModifyPartition settings.

All of the components and settings you added should appear in the Answer File pane. In the Properties
pane, under Settings, select a setting, and enter the appropriate value.

Set the default language of the installation to English (en-US).

Configure both disk partitions.
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12.

13.
14.

15.
16.

17.

Accept the Microsoft Software License terms, and enter a product key to identify the edition of Windows
you are installing.

Select a default home page for Internet Explorer by configuring the InternetExplorer component.

Set the computer to boot to audit mode. (Note: Audit mode enables you to quickly boot to the desktop,
install additional applications and device drivers, and test the installation. With these settings configured
in the answer file, you can use the file to run an unattended installation, so that no user input is required
during Windows Setup.)

Validate the answer file, and resolve any errors.

Skip the several warnings for settings that have not been configured. These settings do not affect the
installation of Windows.

Save the answer file to the root directory of a USB flash drive, and name it Autounattend.xml

Building a reference installation

1.
2.

Insert the USB flash drive that contains the answer file, Autounattend.xml, into a reference computer.
Boot the computer by using the Windows 7 DVD. Next, customize the Windows image on the reference
computer so that you can duplicate it to the destination computers. Windows Setup starts automatically
and detects the answer file on the USB flash drive.
Windows Setup uses the settings specified in the answer file to configure the operating system. When
Windows Setup completes, the computer reboots into audit mode.
Use audit mode to verify customizations.
In audit mode, Windows displays the desktop and the System Preparation Tool, also known as Sysprep.
Use the Sysprep tool to remove computer-specific settings:
a. From the System Cleanup Action list, select Enter System Out-Of-Box Experience to configure
the computer to boot to Windows Welcome the next time it starts.
To remove hardware-specific information from the Windows installation, select Generalize.
c. You must use Generalize before you capture the Windows image, even if deploying to the same
hardware types.
d. Atthe Shutdown Options menu, set the computer to Shut down.

Capturing the customized Windows installation

1.
2.

Boot the computer to the Windows pre-installation environment by using a Windows PE CD.

The customized Windows installation created previously is available on the C drive of the reference
computer.

To copy the contents of the Windows installation to a .wim file, use the ImageX /capture command:

D:\imagex /capture C: C:\myimage.wim “my Win7 Install” /compress fast /verify

Deploying the Windows image

1.

Boot the destination computer to the Windows PE CD (the destination computer is the computer that you
want to deploy the customized Windows image to). When the computer boots from the Windows PE CD,
a command prompt opens.

Create and modify partitions on the hard drive using the script below and the DiskPart tool. (The script
creates a partition that is identical to the one created by the answer file used for the reference image. The
partition is the Windows partition, which will contain the operating system. The Windows patrtition is
assigned the drive letter C.)

X:\windows\system32>Diskpart /s d:\diskpartscript.txt

select disk O
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clean

create partition primary
select partition 1

format fs=ntfs label="windows"
assign letter=C

active

exit

3. When the hard drive is formatted, copy the Windows image from the network location to the local hard
drive:

X:\windows\system32>copy e:\myimage.wim cC:

4. Use the ImageX tool to apply the Windows image to the Windows partition on the C drive. This expands
the contents of the .wim file.

X:\windows\system32>D:\imagex /apply c:\myimage.wim 1 C

5. Use the BCDBoot tool to modify the boot-configuration data on the system patrtition:

E:>bcdboot C:\Windows

Dell OptiPlex 780 desktop

We received the Dell OptiPlex 780 from the factory with ImageDirect already installed. Therefore, we only
measured the amount of time we used with the Microsoft ImageX image solution—to go from unboxing the
desktop to having a functioning system with the following applications and settings:

Adobe Acrobat Reader 8.1.2
Adobe Photoshop CS5
Adobe Dreamweaver CS5
Microsoft Access 2007
Microsoft Excel 2007
Microsoft Outlook 2007
Microsoft PowerPoint 2007
Microsoft Project 2007
Microsoft Word 2007
Microsoft Visio 2007
Microsoft Groove 2007
Microsoft OneNote 2007
Microsoft Publisher 2007
Microsoft InfoPath 2007
SPECjbb2005 v1.07
Symantec EndPoint Protection 11.0.4
WinZip 14.5

We also set the following in the image:
¢ |E home page to www.principledtechnologies.com
e Corporate desktop wallpaper
e Corporate-mandated Policy settings
o Under Security Settings->Account Policies->Password Policy->Change Maximum Password age
to 20 days
o Under Security Settings—>Local Policies=>User Rights Assignment->Add Administrator to Lock
pages in memory (recommended for running SPECjbb2005)
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o Under Security Settings—>Local Policies->Security Options>Rename guest account to PT
Guest

Creating the Dell OptiPlex 780 build using ImageX (34:33 recorded time)
Creating an answer file
1. Insert the Windows 7 product DVD into the DVD drive and locate the Install.wim file in the Sources folder.

2. Launch Windows SIM, a tool installed with the Windows AIK, to create an answer file.

3. On the File menu, click Select Windows Image, and navigate to the location of the Install.wim file.

4. When the installation prompts you to create a catalog file, click Yes.

5. Inthe Answer File pane, choose Create a new answer file. The answer file is divided into the different
phases of Windows Setup, called configuration passes.

6. To add components to the answer file, right-click the desired component, and select the appropriate
configuration pass.

7. To see all of the possible components, expand the component list in the Windows Image pane. (Note:
When you add a component from this list, Windows SIM also adds all the parent settings for this
component to the answer file.)

8. Add two CreatePartition settings and two ModifyPartition settings.

9. All of the components and settings you added should appear in the Answer File pane. In the Properties
pane, under Settings, select a setting, and enter the appropriate value.

10. Set the default language of the installation to English (en-US).

11. Configure both disk partitions.

12. Accept the Microsoft Software License terms, and enter a product key to identify the edition of Windows
you are installing.

13. Select a default home page for Internet Explorer by configuring the InternetExplorer component.

14. Set the computer to boot to audit mode. (Note: Audit mode enables you to quickly boot to the desktop,
install additional applications and device drivers, and test the installation. With these settings configured
in the answer file, you can use the file to run an unattended installation, so that no user input is required
during Windows Setup.)

15. Validate the answer file, and resolve any errors.

16. Skip the several warnings for settings that have not been configured. These settings do not affect the
installation of Windows.

17. Save the answer file to the root directory of a USB flash drive, and name it Autounattend.xml

Building a reference installation
1. Insert the USB flash drive that contains the answer file, Autounattend.xml, into a reference computer.

2. Boot the computer by using the Windows 7 DVD. Next, customize the Windows image on the reference
computer so that you can duplicate it to the destination computers. Windows Setup starts automatically
and detects the answer file on the USB flash drive.

3. Windows Setup uses the settings specified in the answer file to configure the operating system. When
Windows Setup completes, the computer reboots into audit mode.

4. Use audit mode to verify customizations.

5. In audit mode, Windows displays the desktop and the System Preparation Tool, also known as Sysprep.
Use the Sysprep tool to remove computer-specific settings:

a. From the System Cleanup Action list, select Enter System Out-Of-Box Experience to configure
the computer to boot to Windows Welcome the next time it starts.

b. To remove hardware-specific information from the Windows installation, select Generalize.

c. You must use Generalize before you capture the Windows image, even if deploying to the same
hardware types.

d. Atthe Shutdown Options menu, set the computer to Shut down.
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Capturing the customized Windows installation
1. Boot the computer to the Windows pre-installation environment by using a Windows PE CD.

2. The customized Windows installation created previously is available on the C drive of the reference
computer.
3. To copy the contents of the Windows installation to a .wim file, use the ImageX /capture command:

D:\imagex /capture C: C:\myimage.wim “my Win7 Install” /compress fast /verify

Deploying the Windows image

1. Boot the destination computer to the Windows PE CD (the destination computer is the computer that you
want to deploy the customized Windows image to). When the computer boots from the Windows PE CD,
a command prompt opens.

2. Create and modify partitions on the hard drive using the script below and the DiskPart tool. (The script
creates a partition that is identical to the one created by the answer file used for the reference image. The
partition is the Windows partition, which will contain the operating system. The Windows patrtition is
assigned the drive letter C.)

X:\windows\system32>Diskpart /s d:\diskpartscript.txt

select disk 0

clean

create partition primary
select partition 1

format fs=ntfs label="windows"
assign letter=C

active

exit

3. When the hard drive is formatted, copy the Windows image from the network location to the local hard
drive:

X:\windows\system32>copy e:\myimage.wim cC:

4. Use the ImageX tool to apply the Windows image to the Windows partition on the C drive. This expands
the contents of the .wim file.

X:\windows\system32>D:\imagex /apply c:\myimage.wim 1 C

5. Use the BCDBoot tool to modify the boot-configuration data on the system partition:

E:>bcdboot C:\Windows
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Appendix A — System configuration information
Figure 2 provides detailed configuration information about two notebook systems and Figure 3 provides detailed
configuration information about the two desktop systems.

System Dell Latitude E5400 Dell Latitude E6400
General

Number of processor packages | 1 1

Number of cores per processor | 2 2

Number of hardware threads 5 5

per core

System power management Balanced Balanced

policy

Processor power-saving option

Enhanced Intel® SpeedStep® Technology

Enhanced Intel SpeedStep
Technology

System dimensions (length x
width x height)

13-1/4" x 9-1/2" x 1-1/4"

13-1/4" x 9-1/2" x 1-1/4"

System weight 51bs. 10 oz. 5 1bs. 2 oz.
CPU

Vendor Intel Intel

Name Core™ 2 Duo Core 2 Duo
Model number T7250 T8700
Stepping MO RO

Socket type and number of pins | Socket P (478) Socket P (478)
Core frequency (GHz) 2.00 2.53

Bus frequency (MHz) 667 1,066

L1 cache 32 KB + 32 KB (per core) 32 KB + 32 KB (per core)
L2 cache 2,048 KB 3 MB
Platform

Vendor Dell Dell
Motherboard model number 0OD695C 0W620R
Motherboard chipset Intel GM45 Intel GM45

BIOS name and version

Phoenix ROM BIOS PIUS Version 1.10
A15

Dell A17 (09/17/2009)

BIOS settings

Default

Default

Memory module(s)

Vendor and model number

2,048 MB Qimonda
64T256020EDL2.5C2

2,048 MB Samsung M4
70T5663CZ3-CE6

Type PC2-6400 PC2-5300
Speed (MHz) 800 667

Speed running in the system

(MH2) 800 667
Timing/Latency (tCL-tRCD-tRP-

tRASMIN) 6-6-6-18 5-5-5-15
Size (MB) 2,048 4,096
Number of memory module(s) 2 x 2,048 MB 2 x 2,048 MB
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System Dell Latitude E5400 Dell Latitude E6400
Chip organization (single- i "
sided/double-sided) Double-sided Double-sided

Channel (single/dual) Dual Dual

Hard disk

Vendor and model number

Seagate ST9120312AS

Seagate ST980313AS

Number of disks in system 1 1

Size (GB) 120 80

Buffer size (MB) 8 8

RPM 5,400 5,400

Type SATA 3.0 Gb/s SATA 3.0 Gh/s

Controller Intel 82801IM (ICH9-M) Intel 82801IM (ICH9-M)

Driver Intel 6.9.1001 (02/20/2008) Intel 9.6.0.1014 (03/03/2010)
Operating system

Name Microsoft Windows 7 Enterprise Microsoft Windows 7 Enterprise

Build number

7600

7600

Service Pack N/A N/A

File system NTFS NTFS

Kernel ACPI x86-based PC ACPI x86-based PC
Language English English

Microsoft DirectX version DirectX 11 DirectX 11
Graphics

Vendor and model number

Mobile Intel GMA X4500HD

Mobile Intel GMA 4500MHD

Type Discrete Discrete
. Mobile Intel 4 Series Express Chipset Mobile Intel 4 Series Express
Chipset : )
Family Chipset
BIOS version 1659.0 1659.0
Total available graphics 1,545 1,543
memory (MB)
Dedicated video memory (MB) | 32 32
System video memory (MB) 32 32
Shared system memory (MB) 1,481 1,479

Resolution

1,280 x 800 x 32 hit

1,280 x 800 x 32 hit

Driver

Intel 8.15.10.1749 (05/06/2009)

Intel 8.15.10.1855 (07/28/2009)

Sound card/subsystem

Vendor and model number

High Definition Audio

IDT High Definition Audio CODEC,
Intel High Definition Audio HDMI

Driver

Microsoft 6.1.7600.16385 (07/13/2009)

IDT 6.10.0.6227 (07/31/2009), Intel
6.10.1.2073 (05/26/2009)

Ethernet

Vendor and model number

Broadcom NetXtreme 57xx Gigabit

Intel 82567LM Gigabit

Driver

Microsoft 10.100.4.0 (04/26/2009)

Intel 10.0.6.0 (06/12/2009)

Wireless

Vendor and model number

Dell Wireless 1397 WLAN Mini-Card

Intel 5100 AGN

Driver

Microsoft 4.176.75.21 (10/01/2008)

Intel 1.1.1.1 (01/13/2010)

Optical drive(s)

Vendor and model number

HL-DT-ST DVD+-RW GT10N ATA

Matshita UJ862A

Type

DVD+-RW

DVD+-RW
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System

Dell Latitude E5400

Dell Latitude E6400

USB ports

Number 4 4

Type 2.0 2.0
IEEE 1394 ports

Number | 1 (4-pin) [ 1 (4-pin)
Monitor

LCD type WXGA WXGA
Screen size (inches) 14.1 14.1
Refresh rate (Hz) 60 60
Battery

Type Dell KM742 lithium-ion Dell PT434 lithium-ion

Size (length x width x height)

8-1/8" x 2" x 3/4"

8-1/4" x 2" x 3/5"

Rated capacity

5,050 mAh / 11.1V (56Wh)

5,050 mAh / 11.1V (56Wh)

Weight

11 oz.

11 oz.

Figure 2. Detailed system configuration information for the two notebook systems.
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System

Dell OptiPlex 780

Dell Precision T1500

General

Number of processor packages 1 1
Number of cores per processor 2 4
Number of hardware threads per 5

core

System power management Balanced Balanced

policy

Processor power-saving option

Enhanced Intel SpeedStep
Technology

Enhanced Intel SpeedStep
Technology

CPU

Vendor Intel Intel

Name Pentium® Processor E5400 Core i5

Model number E5400 750

Stepping RO Bl

Socket type and number of pins | Socket 775 LGA LGA1156

Core frequency (GHz) 2.70 2.67

Bus frequency 800 MHz 2,400 QPI Link

L1 cache 32 KB + 32 KB (per core) 32 KB + 32 KB (per core)
L2 cache 2 MB 1 MB (256 KB per core)
L3 cache N/A 8 MB

Platform

Vendor Dell Dell

Motherboard model number 0200DY OP67HD

Motherboard chipset Intel Q45 Intel P55

BIOS name and version Dell A04 (04/30/2010) Dell 2.0.2 (12/25/2009)
BIOS settings Default Default

Memory module(s)

Vendor and model number

Kingston KP223C-ELD

Elpida EBJ21UE8BBFO0-DJ-F

Type PC3-10700 PC3-10700
Speed (MHz) 1,333 1,333

Speed running in the system

(MH2) 800 1,333
Timing/Latency (tCL-tRCD-tRP-

tRASMIN) 6-6-6-15 9-9-9-24
Size (MB) 2,048 4,096
Number of memory module(s) 1x 2,048 MB 2 x 2,048 MB
Chip organization (single- i =
sided/double-sided) Double-sided Double-sided
Channel (single/dual) Single Dual

Hard disk

Vendor and model number

Western Digital WD1600AAJS-
75MOAO

Western Digital WD1600AAJS-
75MOAQ

Number of disks in system

1

1
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System

Dell OptiPlex 780

Dell Precision T1500

Size (GB) 160 160

Buffer size (MB) 8 8

RPM 7,200 7,200

Type SATA 3.0 Gb/s SATA 3.0 Gb/s
Controller Intel 82801JB (ICH10) Intel 82801IR (ICH9R)
Driver Intel 8.9.0.1023 Microsoft 6.1.7600.16385

(06/04/2009)

(06/21/2006)

Operating system

Name

Microsoft Windows 7 Enterprise

Microsoft Windows 7 Enterprise

Build number

7600

7600

Service Pack N/A N/A

File system NTFS NTFS

Kernel ACPI x86-based PC ACPI x86-based PC
Language English English

Microsoft DirectX version DirectX 11 DirectX 11
Graphics

Vendor and model number Intel 4 Series Internal Chipset NVIDIA® Quadro® NVS 295
Type Discrete Discrete

Chipset Intel 4 Series Internal Chipset Family | Quadro NVS 295
BIOS version 1785.0 62.98.56.0.11

;rl\(/l)g available graphics memory 781 1,531

Dedicated video memory (MB) 32 256

System video memory (MB) 32 0

Shared system memory (MB) 717 1,275

Resolution

1,280 x 1,024 x 32 bit

1,280 x 1,024 x 32 bit

Driver

Intel 8.15.10.1872 (08/13/2009)

NVIDIA 8.15.11.9038 (07/14/2009)

Sound card/subsystem

Vendor and model number

SoundMAX Integrated Digital High
Definition Audio

High Definition Audio

Driver

Analog Devices 6.10.1.7260
(02/22/2009)

Microsoft 6.1.7600.16385
(07/13/2009)

Ethernet

Vendor and model number

Intel 82567 M-3 Gigabit

Broadcom NetLink Gigabit

Driver

Intel 11.5.10.0 (12/10/2009)

Broadcom 12.2.2.2 (08/06/2009)

Optical drive(s)

Vendor and model number N/A LG GH50N

Type N/A DVD-RW

USB ports

Number 8 10

Type 2.0 2.0

IEEE 1394 ports

Number [0 2

Monitor

LCD type Samsung SyncMaster 997DF Samsung SyncMaster 997DF

Screen size (inches)

19

19

Refresh rate (Hz)

85

85

Figure 3. Detailed system configuration information for the two desktop systems.
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Appendix B — Detailed results

Figure 4 provides more details on the test times of the individual tasks and activities for each of the systems with

Dell ImageDirect and with Microsoft ImageX.

Dell Latitude
Dell Latitude E6400 . Dell Precision
E5400 (corporate image De(lfl‘e‘(;[())tlptl)m d7)80 T1500
(base build) with updated ry (corporate image?)
applications®)
. . Image- Image- Image- Image-

Timed activities Direct ImageX Direct ImageX Direct ImageX Direct ImageX
lgttjl'oone'“me 0:00:00 | 0:00:00 | 0:04:07 | 0:52:13 | 0:00:00 | 0:34:33 | 0:02:46 | 0:37:40
Install Windows 7 N/A N/A N/A 0:22:57 N/A 0:12:27 N/A 0:14:41
Upload new
applications/edit N/A N/A N/A 0:17:57 N/A 0:11:24 N/A 0:13:32
image/audit
image
Download and N/A N/A N/A N/A N/A 0:02:58 N/A N/A
install drivers
Install N/A N/A N/A 0:26:12 N/A 0:17:33 N/A 0:11:39
applications
Customize image N/A N/A N/A 0:03:09 N/A 0:02:16 N/A 0:02:41
Total 0:12:07 0:40:08 0:12:03 0:43:30 0:08:10 0:26:29 0:05:13 0:32:13
deployment
Unbox system 0:02:26 0:02:26 0:02:22 0:02:22 0:01:59 0:01:59 0:02:27 0:02:27
iPrr?;Vng on/deploy | .09:41 | 0:10:45 | 0:09:41 | 0:14:07 | 0:06:11 | 0:10:45 | 0:02:46 | 0:10:19
Install additional N/A 0:30:52 N/A 0:25:03 N/A 0:13:15 N/A 0:24:20
applications
Total remote site
additional 0:00:00 0:09:46 0:00:00 0:09:42 0:00:00 0:10:47 0:00:00 0:11:47
deployment
Repack system
(average for N/A 0:07:20 N/A 0:07:20 N/A 0:07:20 N/A 0:07:20
all systems)
Sgpa‘:k and set N/A 0:02:26 N/A 0:02:22 N/A 0:03:27 N/A 0:04:27

Figure 4. The organization’s tested times for setting up images and deploying systems using them both to a single site and to a
remote site. The times are in hours:minutes:seconds.

! See Page 6 for details on the one-time setup of the updated corporate image on the Dell Latitude E6400.
% See Page 4 for details on the one-time setup of the corporate image on the Dell Precision T1500.
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About Principled Technologies

We provide industry-technology assessment and fact-based marketing services. We bring to every assignment
extensive experience with and expertise in all aspects of technology testing and analysis, from researching new
technologies, to developing new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We

provide our clients with the materials they need, from market-focused data to use in their own collateral to custom
sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results
of our trusted independent analysis.

We provide customized services that focus on our clients’ individual requirements. Whether the technology
involves hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help you
assess how it will fare against its competition, its performance, whether it's ready to go to market, and its quality
and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in technology assessment for over 20
years. As journalists, they published over a thousand articles on a wide array of technology subjects. They
created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff
Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that
company by Lionbridge Technologies were the head and CTO of VeriTest.

-‘ Principled Technologies, Inc.
e 1007 Slater Rd., Suite 300
PrlnCIpled Durham, NC 27703

‘ I Technologies® www.principledtechnologies.com

info@principledtechnologies.com

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS
TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR
IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING
ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE
RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS
EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE
ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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